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Background

The AEC (UK) CAD Standards Initiative was formed in 2000 to improve the process of
design information production, management and exchange. Initially the initiative addressed
CAD layering conventions as the primary concern for users of design data. As design
needs and technology has developed, the initiative has expanded to cover other aspects of
design data production and information exchange.

The committee was re-formed in 2009, including new members from companies and
consultancies highly experienced in BIM software and implementation, to address the
growing need within the UK AEC industry for a unified, practical & pragmatic integrated
CAD and BIM standard in a design environment.

The AEC (UK) CAD Standard Basic Layer Code was originally released in 2001; this
update is provided to align with the main BIM Protocol and the release of Uniclass 2015.
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The Committee

The group has representatives from architectural, engineering and construction companies
in the UK, large and small, hence the adoption of the AEC (UK) moniker. The BIM
committee is working together to realise a unified, usable, co-ordinated approach to
Building Information Modelling in a design environment.

Committee Members
Nigel Davies (Committee Chair) Evolve Consultancy

Lewis Wenman Murphy Group

Paul Woddy White Frog

Ray Purvis Atkins Global

Rob Clarke Excitech

Rob Jackson Bond Bryan Architects

Stephen Shorter Stephen Shorter

Contributors
Martyn Horne Computers Unlimited

Stephen Holmes Foster & Partners

For full contact details and further information on the committee, please refer to
aecuk.wordpress.com.
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Disclaimer

All the advice outlined in this document is for information only. The authors and contributing
companies take no responsibility for the utilisation of these procedures and guidelines.
Their suitability should be considered carefully before embarking upon any integration into
your current working practices.
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Scope

The AEC (UK) protocols define procedures and methodologies from a broad consensus of
experienced users from all disciplines, as well as consultants, who represent the leading
consulting engineering and architectural organisations in the UK, to address industry best
practice irrespective of software platform, in addition to guidelines defined by world-wide
standardisation initiatives, with close alignment to BS1192:2007+A1:2015.

In particular, this protocol expands upon the principles defined within the recently updated
Uniclass conventions and requests driven by the AEC (UK) Protocols use in the workplace.

The AEC (UK) Protocol for Layer Naming builds on the guidelines defined in
BS1192:2007+A1:2015, and the complimentary AEC (UK) BIM Technology Protocols,
providing a base starting point for a unified CAD & BIM layering standard that can easily be
adopted “as is” or developed and adapted for implementation within companies that have
specific requirements for the structuring of their digital production data. This document
provides platform-independent guidelines for layer naming.

Copyright Notice:

It is important to note that this standard will only become truly useful if as many companies
adopt it as possible. To that extent, it may be freely distributed and used in any format
necessary.
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The Layer Naming Standard

Layers are used to logically group sets of similar elements. When grouping elements in this
manner, it is imperative that the groups can be identified quickly and easily by anyone who
needs to access or use the information. This means that the layer names should conform
to a consistent naming convention so that everyone always knows where to look for the
information they require to “communicate, re-use, and share data efficiently without loss,
contradiction or misinterpretation”.

Layer naming should be common throughout all types of digital production data. It should
not differ for 2D or 3D elements – that is picked up by the filename.

The AEC (UK) Protocol for Layer Naming provides five fields separated by a hyphen or
dash1, to classify a layer based on the conventions outlined in BS1192:2007+A1:2015 for
container naming within a file. Viewed complete, it provides a unique reference to a logical
collection of elements:

Field 1: Role
1-2 char, required

The AEC (UK) adopts this field but expanding it to 2 characters in line with ISO13567.
Additional standard disciplines have been added that are missing from
BS1192:2007+A1:2015.

Refer to the

Field 1: Role section, page 9.

Field 2: Classification
5+ char, required

This is the critical field for identification on the content of the layer. The actual code value is
taken from the Uniclass 2015 system, tables Ee, Pr, SL, and Ss.

A typical set of layers is provided in the accompanying spreadsheet appendices but full
listings can be obtained from
https://toolkit.thenbs.com/articles/classification#classificationtables.

An additional table, Zz Non-physical Elements is defined below in the Field 2: Table Zz
(Non-physical Elements) section, page 11.

Field 3: Presentation
1 char, required

The adoption of this field is revised from earlier versions of the AEC (UK) CAD Standard to
comply with BS1192:2007+A1:2015.
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Refer to Field 3: Presentation, page 18

The above are mandatory in BS1192:2007+A1:2015, the following are optional:

Field 4: Description
Variable length (recommended 40 chars maximum2), required

The Description field is adopted using Uniclass 2015 definitions.

Guidelines are provided in section Field 4: User Description on page 19.

Field 5: View
3 char, optional

Not provided in BS1192:2007+A1:2015, the optional View suffix defines how the element is
viewed i.e. whether it is shown in elevation, section or hidden. The order of this field after
the Description is important to allow custom layers to be grouped together.

Definitions are listed in section Field 5: View on page 20.

Notes
1 For strict BS1192:2007+A1:2015 compliance, an underscore should be used prior to

the description. The AEC (UK) does not follow this convention, as the underscore is
a non-breaking character, contrary to other field-based naming standards, and
confusing now that Uniclass 2015 utilises underscores between categories. Using an
underscore does not contravene the AEC (UK) conventions and may be used if
necessary.

2 To maintain legibility and compatibility with all CAD systems, it is recommended that
the total layer name length, including field dividers, is limited to 64 characters.
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Field 1: Role
The letters A to Z define the author, or owner, of the data. This allows various disciplines to
use the same Classification codes.

Discipline Codes
BS1192:2007+A1:2015 standard codes
shown in bold

Cont…

A Architects W Contractors
B Building surveyors X Sub-contractors
C Civil engineers Y Specialist designers

CB Bridge engineers YA Acoustic engineers
CR Road / highway engineers YE Environmental engineers
CW Water / dam engineers YF Fire engineers

D Drainage YL Lighting engineers (non-
Building Services)

E Electrical engineers Z General (non-specific)
EC Cable Containment
EF Fire Alarms
EL Lighting
EP Protection
ES Security

F Facilities Manager
G GIS, land surveyors

GA Aerial surveyors
H Heating and Ventilation
I Interior designers
K Client
L Landscape architects
M Mechanical engineers

ME Combined Services
MW Chilled Water
MH Heating
MV Ventilation

P Public health
PD Drainage
PF Fire Services
PH Public Health Services
PS Sanitation and Rainwater
PW Water Services

Q Quantity surveyors
R Rail

RS Railways signaling
RT Railways track

S Structural engineers
SF Façade engineers
SR Reinforcement detailers

T Town & country planners
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Field 2: Classification
The Classification code describes the design component and is the most important field in
identifying the component.

It uses a Uniclass 2015 value from the follow tables:

SL Spaces / Locations

Ee Elements

Ss Systems

Pr Products

and the additional AEC (UK) table:

Zz Non-physical Elements

Note: Generic vs specific
The tables are broadly hierarchical and should be used to define an element as precisely
as possible. Where the exact type of element is not known or not required, a generic code
should be used from the Ee Elements table in preference to the exact type from Ss
Systems or Pr Products.

 Ee_25_10 would be used for walls when a more detailed definition is not known (for
example in the early stages of design), as opposed to Ss_25_10_20 for Curtain Walls.

 Ee_50_70 may be used for general drainage locations in an architectural model,
whereas Ss_50_30_08_30 would provide the more specific details of the foul waste
water pipes in an engineering model. Pr_65_52_63_61 might then be used for
engineering details where the exact pipe and fittings are specified.

In simple architectural terms, Ee might be used for CAD work, where many specific layers
are not required, Ss for detail work or components that designed as part of a system for
construction onsite, and Pr for fit out or components that are procured.
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Field 2: Table Zz (Non-physical Elements)
The AEC (UK) classifications below expand and revise Uniclass Table Z (originally adopted
from the AEC (UK) documentation), providing a more structured provision specifically for
non-physical, CAD- or BIM-based elements.

Red text = edited from Uniclass 2015

Green text = additions to Uniclass 2015

Code Classification Title Layer Description

Zz_10 Drawing Sheet DrawingSheet

Zz_10_20 Drawing Frame DrawingFrame

Zz_10_20_25 Drawing Frame Outline DrawingFrameOutline

Zz_10_20_45 Logo Logo

Zz_10_20_85 Title Block TitleBlock

Zz_10_20_95 Viewports Viewport

Zz_10_40 Hold Clouds And Notation HoldCloudAndNotation

Zz_10_70 Revisions Revision

Zz_10_70_05 Revision Annotation RevisionAnnotation

Zz_10_70_10 Revision Linework RevisionLinework

Zz_10_70_20 Clouds And Notations CloudAndNotation

Zz_10_80 Status Stamps StatusStamp

Zz_10_90 Watermarks Watermark

Zz_20 Textual Content TextualContent

Zz_20_10 Annotation Annotation

Zz_20_10_40 Keynotes Keynote

Zz_20_10_45 Labels Label

Zz_20_10_50 Leaders Leader

Zz_20_10_55 Notes Note

Zz_20_10_70 Reference Reference

Zz_20_10_70_05 Accessory Reference AccessoryReference

Zz_20_10_70_08 Area References AreaReferences

Zz_20_10_70_10 Ceiling Reference CeilingReference

Zz_20_10_70_20 Door Reference DoorReference

Zz_20_10_70_30 Finish Reference FinishReference

Zz_20_10_70_32 Fire Reference FireReference

Zz_20_10_70_35 Floor Reference FloorReference

Zz_20_10_70_38 Furniture Reference FurnitureReference

Zz_20_10_70_40 Lighting Reference LightingReference
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Zz_20_10_70_55 Partition Reference PartitionReference

Zz_20_10_70_60 Room Description RoomDescription

Zz_20_10_70_65 Room Number RoomNumber

Zz_20_10_70_68 Room Reference RoomReference

Zz_20_10_70_70 Signage Reference SignageReference

Zz_20_10_70_75 Stair Reference StairReference

Zz_20_10_70_90 Wall Reference WallReference

Zz_20_10_70_92 Wall Cladding Reference WallCladdingReference

Zz_20_10_70_95 Window Reference WindowReference

Zz_20_10_85 Tags Tags

Zz_20_10_90 Text Text

Zz_20_20 Dimensions Dimensions

Zz_20_30 General Masking GeneralMasking

Zz_20_30_50 Masks Masks

Zz_20_30_95 Wipeouts Wipeouts

Zz_20_40 Hatching & Area Fill HatchingAreaFill

Zz_20_40_05 Outlines Outline

Zz_20_40_35 Hatching Hatching

Zz_20_40_60 Patterning Patterning

Zz_20_40_80 Area Fill AreaFill

Zz_20_40_80_30 Colour Fill ColourFill

Zz_20_40_80_80 Solid Fill SolidFill

Zz_20_70 Redlining Redline

Zz_20_70_20 Comments Comment

Zz_20_70_50 Linework Linework

Zz_20_80 Symbols Symbol

Zz_20_80_10 Barscales Barscale

Zz_20_80_15 Cross References CrossReference

Zz_20_80_40 Key Plan KeyPlan

Zz_20_80_50 Legends Legend

Zz_20_80_55 North Point NorthPoint

Zz_20_90 Title Annotation TitleAnnotation

Zz_20_90_30 Copyright Copyright

Zz_20_90_60 Notes Note

Zz_30 Insertions Insertion

Zz_30_20 Blocks And Cells BlockAndCell

Zz_30_30 External References ExternalReference
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Zz_30_40 Images Image

Zz_30_60 Objects Object

Zz_30_90 Tables And Schedules TableAndSchedule

Zz_30_90_10 Schedules Schedule

Zz_30_90_10_05 Annotation ScheduleAnnotation

Zz_30_90_10_40 Headings ScheduleHeading

Zz_30_90_10_45 Linework ScheduleLinework

Zz_30_90_10_90 Text ScheduleText

Zz_30_90_60 Tables Table

Zz_30_90_60_05 Annotation TableAnnotation

Zz_30_90_60_40 Headings TableHeading

Zz_30_90_60_45 Linework TableLinework

Zz_30_90_60_90 Text TableText

Zz_35 Setting Out SettingOut

Zz_35_10 Alignments And Super Elevations AlignmentsAndSuperElevation

Zz_35_10_40 Horizontal Alignment HorizontalAlignment

Zz_35_10_80 Super Elevation SuperElevation

Zz_35_10_90 Vertical Alignment VerticalAlignment

Zz_35_20 Centrelines Centreline

Zz_35_30 Geospatial Control Points GeospatialControlPoint

Zz_35_40 Gridlines Gridline

Zz_35_40_20 Ceiling Grid CeilingGrid

Zz_35_40_20_45 Ceiling Grid Labels CeilingGridLabel

Zz_35_40_45 Grid Labels GridLabel

Zz_35_40_60 OS Grid OSGrid

Zz_35_40_60_45 OS Grid Labels OSGridLabel

Zz_35_40_80 Structural Grid StructuralGrid

Zz_35_40_80_45 Structural Grid Labels StructuralGridLabel

Zz_35_40_85 Secondary Structural Grid SecondaryStructuralGrid

Zz_35_40_85_45 Secondary Structural Grid Labels SecondaryStructuralGridLabel

Zz_35_60 Points Point

Zz_35_60_80 Setting Out Points SettingOutPoint

Zz_35_80 Survey Control Points SurveyControlPoint

Zz_35_80_20 Bench Mark BenchMark

Zz_35_80_20_60 OS Bench Mark OSBenchMark

Zz_35_80_20_80 Site Bench Mark SiteBenchMark

Zz_35_80_20_90 Temporary Site Bench Mark TemporarySiteBenchMark
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Zz_35_80_30 Control Station ControlStation

Zz_35_80_30_60 OS Trigonometrical Station OSTrigonometricalStation

Zz_35_80_30_80 Site Survey Control Station SiteSurveyControlStation

Zz_40 Topography Topography

Zz_40_15 Contours Contour

Zz_40_15_50 Major Contours MajorContour

Zz_40_15_55 Minor Contours MinorContour

Zz_40_20 Cuttings And Embankment Indicators CuttingsAndEmbankmentIndicator

Zz_40_50 Level Indicators LevelIndicators

Zz_50 Zoning and Boundaries ZoningandBoundary

Zz_50_10 Boundaries Boundary

Zz_50_10_10 Site Site

Zz_50_10_15 Adjoining Land AdjoiningLand

Zz_50_15 Access Access

Zz_50_15_05 Access Outlines AccessOutline

Zz_50_15_05_30 Existing Access ExistingAccess

Zz_50_15_05_35 Existing Access to be Extinguished ExistingAccesstobeExtinguished

Zz_50_15_05_40 Existing Access to be Retained ExistingAccesstobeRetained

Zz_50_15_05_55 New Access NewAccess

Zz_50_15_05_90 Temporary Access TemporaryAccess

Zz_50_20 Areas Area

Zz_50_20_10 Area Outlines AreaOutline

Zz_50_20_20 Room Outlines RoomOutline

Zz_50_20_30 External Areas ExternalArea

Zz_50_20_30_40 Gross External Area GrossExternalArea

Zz_50_20_30_80 Private External Areas PrivateExternalArea

Zz_50_20_30_88 Public External Areas PublicExternalArea

Zz_50_20_35 Internal Areas InternalArea

Zz_50_20_35_40 Gross Internal Area GrossInternalArea

Zz_50_20_35_55 Net Internal Area NetInternalArea

Zz_50_30 Complexes Complex

Zz_50_30_20 Complexes Outlines ComplexOutline

Zz_50_30_30 Entities / Facillities / Buildings
Outlines

Outline

Zz_50_30_30_05 Existing Entities / Facilities / Buildings
to be Altered Outlines

ExistingAlteredOutline

Zz_50_30_30_30 Existing Entities / Facilities / Buildings
Outlines

ExistingOutline
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Zz_50_30_30_35 Existing Entities / Facilities / Buildings
to be Demolished Outlines

ExistingToBeDemolishedOutline

Zz_50_30_30_40 Existing Entities / Facilities / Buildings
to be Retained Outlines

ExistingToBeRetainedOutline

Zz_50_30_30_55 New Entities / Facilities / Buildings
Outlines

NewOutline

Zz_50_30_30_57 New Extension to Entities / Facilities /
Buildings Outlines

NewOutline

Zz_50_50 Lots Lot

Zz_50_60 Parcels Parcel

Zz_50_90 Volumes Volume

Zz_50_95 Zones Zone

Zz_60 Drawing Symbols DrawingSymbol

Zz_60_20 Detail Call Ups DetailCallUp

Zz_60_30 Fall Indicators FallIndicator

Zz_60_40 Joint Lines JointLine

Zz_60_40_15 Construction Joints ConstructionJoint

Zz_60_40_20 Contraction Joints ContractionJoint

Zz_60_40_30 Expansion Joints ExpansionJoint

Zz_60_45 Levels Levels

Zz_60_45_20 Datum Datum

Zz_60_45_60 Original Ground Level OriginalGroundLevel

Zz_60_45_70 Regrade Ground Level RegradeGroundLevel

Zz_60_50 Markers Marker

Zz_60_50_10 Break Marks BreakMark

Zz_60_50_20 Callout Marks CalloutMark

Zz_60_50_30 Elevation Marks ElevationMark

Zz_60_50_60 Plan Plan

Zz_60_50_80 Section Marks SectionMark

Zz_60_50_85 Span Direction Markers SpanDirectionMarker

Zz_60_50_90 Void And Opening Markers VoidAndOpeningMarker

Zz_60_55 Match Lines MatchLine

Zz_70 Views View

Zz_70_05 3D Views 3DView

Zz_70_20 Details Detail

Zz_70_30 Elevations Elevation

Zz_70_60 Plans Plan

Zz_70_80 Sections Section
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Zz_70_90 Visualisations Visualisation

Zz_80 Presentation Presentation

Zz_80_30 Entourage Entourage

Zz_80_45 Lines Line

Zz_80_60 People People

Zz_80_85 Trees And Planting TreesAndPlanting

Zz_80_90 Vehicles Vehicle

Zz_80_90_85 Turning Circles TurningCircle

Zz_85 Generic 3D Generic3D

Zz_85_05 3D Solids 3DSolid

Zz_85_05_60 Paths Path

Zz_85_05_80 Solids Solid

Zz_85_05_85 Solid Voids SolidVoid

Zz_85_20 Concept Concept

Zz_85_20_20 Concept Massing ConceptMassing

Zz_85_20_50 Mass Group MassGroup

Zz_85_20_55 Mass Slice MassSlice

Zz_90 Readme And Plotting Lines ReadmeAndPlottingLine

Zz_90_20 Construction Lines ConstructionLine

Zz_90_30 External Reference Information ExternalReferenceInformation

Zz_90_55 Non-plotting Non-plotting

Zz_90_70 Readme Readme

Note: Use of annotation
The provision of layers for annotation is broken down into annotation types. This means
there can be repetition. In these cases, refer to the parent classification for guidance:

 Zz_20_10_55 is used for general annotation notes. This might include clarification of a
construction detail or notes related to a design element.

 Zz_20_90_60 is specifically title annotation notes, which should be used for drawing
notes on a drawing sheet, for example “Do not scale from this drawing”.

Note: Use of outlines
Table Zz provides a number of layers for linework and outlines for draughting and
modelling. At first it can appear that there is a certain amount of overlap between elements
in Table Zz classifications and SL Spaces / Locations. The intention for usage for certain
classifications is as follows:

1. Hatching & Area Fill vs Zoning / Outlines
The two sections, Zz_20_40 Hatching & Area Fill and Zz_50 Boundaries have two
distinct uses:
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 Zz_20_40 is an annotative section; it should be used for adding hatching, solid
fill or colour fills over a design. Zz_20_40_05 would be used for the shape that
contains hatching or fill if it needs to be defined as a separate layer to the fill
(so it can be turned off independently).

 Zz_50 is specifically for identifying physical, legal and design boundaries.

2. Room Outlines vs Rooms
Table SL Spaces / Locations defines specific usage of rooms and should be used
when the occupancy type needs to be specified.

 SL_20_50_28 should be used for defining an Executive Office.

For the earlier stages of design, it may be necessary to distinguish between the
overall usage of an area or zone and also show the intended room layouts within
that area or zone:

 SL_20_64 would define a retail space
 The rooms within that retail may be defined as Zz_50_20_20 before their exact

use (e.g. office space, showroom, secure areas) is known.

Note: Use of trees and planting
Table Zz provides a layer for trees and planting which can be confused with the extensive
tree classifications in Pr Products and flora in Ee Elements.

 Zz_80_85 should only be used for trees and planting where this is used for purely
aesthetic presentation or enhancement work on a drawing or model. An example of
this would be tree outlines on an architectural elevation or visualisation model.

 Table Ee’s entry, Ee_45_40 Flora, might be used for generic plants in a design, i.e. if
there is a responsibility for the design and procurement of the plants.

 Table Pr Products would then be used when defining detailed vegetation layouts or
landscaping works.
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Field 3: Presentation
Presentation indicates the type of data associated with the layer.

Code Description

D Dimensions

H Hatching, Shading, Fill, Patterning

M Model-related elements

P Paper-related elements

T Text

X Existing
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Field 4: User Description
Used to describe any part of the previous fields or any other aspect of the CAD data.
Usually used as an English text string to clarify the Element codes used in Field 2. It is
advised to use “CamelCase” (i.e. each word begins with a single capital, the remainder in
lowercase and any words are concatenated without spaces) for clarity and comprehension.

Note: Plurals
It is recommended that only singular descriptions are used for consistency:

 Use Wall instead of Walls
 Lift instead of Lifts
 CommunicationCable instead of Communications Cables

Note: Non-existent classifications
Where Uniclass 2015 does not provide a classification, additional layers may be created
using a higher level Uniclass value and a unique description field:

 For brise soliel use Ss_25_50_45 with a description of BriseSoliel.
 For builder’s work holes, use either Zz_60_50_90 with a description of

BuildersWorkHole or use the system to which they relate, e.g. Ss_30_75 for floor
drainage.

 For HVAC use Ss_65 with a description of HVAC.
 For timber roof purlins, use Ss_30_10_30_85 with a description of TimberPurlin.
 Vertical steel bracing is not defined as a specific structural engineering item. It is

therefore best to use an extended layer description and a related classification.
Ss_20_10_75_35 is used for steel framing systems, in which bracing would be
included, allowing related layers to be viewed together, rather than use
Pr_20_85_84_88. The equivalent layer might therefore be:
S-Ss_20_10_75_35-M-BracingSteelVertical.
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Field 5: View
Common to many practices, and added as part of the User Description field, although not
covered in BS1192:2007+A1:2015, the optional View field allows a user to define whether
the elements are shown as cut (as a wall in section or a column in plan), forward (as a
window in elevation), hidden (as beams below a slab) or reflected (as anything shown
behind the direction of view, such as any part of a reflected ceiling plan).

This can be especially useful when defining layers of varying properties for 2D views from
3D models.

Code Description

Cut Information lying on the cut line.
e.g. walls in plan or floors in a section.

Fwd Elements viewed forward of the section cut line.
e.g. a kerb edge or floor outline in plan; walls in an elevation.

Hid Elements hidden from view by another object, but still shown.
e.g. a structural beam below a floor or buried drainage runs.

Rfl Reflected information above the section cut line.
e.g. ceiling layouts.

Note: Using the View field as opposed to extending the Presentation field
In certain cases, recommendations have been authored to extend the presentation field
using MC, MF, MH and MR. The AEC (UK) recommends against this to ensure that layers
are grouped according to their contents, not their view. This is especially noticeable in the
cases of many custom layers.

For example, considering a detailed breakdown of a concrete wall types listed in logical
groupings using AEC (UK) View conventions

S-Ss_25_11_16-M-ConcreteWallCore
S-Ss_25_11_16-M-ConcreteWallCore-Cut
S-Ss_25_11_16-M-ConcreteWallCore-Fwd
S-Ss_25_11_16-M-ConcreteWallCore-Hid
S-Ss_25_11_16-M-ConcreteWallExternal
S-Ss_25_11_16-M-ConcreteWallExternal-Cut
S-Ss_25_11_16-M-ConcreteWallExternal-Fwd
S-Ss_25_11_16-M-ConcreteWallExternal-Hid
S-Ss_25_11_16-M-ConcreteWallInternal
S-Ss_25_11_16-M-ConcreteWallInternal-Cut
S-Ss_25_11_16-M-ConcreteWallInternal-Fwd
S-Ss_25_11_16-M-ConcreteWallInternal-Hid

The layers are grouped sensibly so that all concrete wall types are listed together.
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Examples
To help clarify the use of these conventions, the examples below demonstrate some
applications of the AEC (UK) protocol to everyday items:

Layer name Description

A-Ee_30_40-M-Floor An architect’s floor outline.

S-Ss_30_12_85_18-M-Slab A structural engineer’s slab outline.

S-Ss_30_12_85_18-M-Slab-Cut A structural engineer’s slab outline showing cut elements.

I-Pr_40_50_21_21-M-Desk An interior designer’s desk.

M-Ss_65-M-HVAC-Fwd A mechanical engineer’s HVAC duct in elevation or plan.

A-Zz_20_20-D-Dimension An architect’s dimension layer.
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Appendices
Best practice guides for implementing layer naming

Autodesk AutoCAD
Layer creation & management can be achieved in many different ways. The
implementation that is best for you depends on your existing methods for controlling
AutoCAD standards: if you use Design Center, create a file to store your required layers
that can be added to your working DWG files; if you use custom menus*, continue to use
those, although this may not be the most flexible or adaptable.

We would advise against building a standard template of all possible layer names. This will
result in a large and unwieldy file which would have many layers unused.

Aside from using custom tool development, defining a library in Design Center will most
likely be the easiest.

Always remember to utilise the layer description to allow users to order layers and search
using English terms.

* an example command used might be:

-layer;make;E-Ss_70_10-M-ElectricalPowerGeneration;;-
layer;color;yellow;;;-color bylayer;-layer;ltype;continuous;;;-
linetype set bylayer;;-layer;lweight;0.25;;;-lweight;bylayer;-
layer;pstyle;0.25mm;;;
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Autodesk Revit
As Revit does not utilise layers in the same way as other CAD packages, it can be easy to
forget the importance of layers in data exchange. Exchanging files with CAD systems,
including DWG and DGN, as well as BIM data exchanges using IFC require you to have
developed mapping tables to map categories to layers.

The important file to ensure matches the layers defined in this document is:

C:\ProgramData\Autodesk\<product>\exportlayers-dwg-BS1192.txt

Autodesk as yet do not provide a Uniclass 2015 version. The AEC (UK) team is working on
providing one free of charge in the near future, but for now, editing a copy of this (i.e.
exportlayers-dwg-Uniclass2015.txt) to match the Uniclass 2015 layers should be high on
your priority list.
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Bentley MicroStation & AECOsim Building Designer
Level creation and management in Bentley tools should be carried out using a dgnlibs with
your standard set of levels pre-defined. Revisit your standard list of levels and identify the
Uniclass 2015 code most suited to your requirements. Do not create new levels simply
because they are now available, but instead work using your existing levels to maintain
continuity for your users. Keep your lists as short and simple to use as is possible.

Develop your dgnlibs using Excel and save the file as a .csv to import directly into a dgnlibs
rather than build each level using Level Manager. This allows you to cut & paste items from
the NBS Uniclass listings or to download complete tables and work with them. If you are
unsure of the correct formatting needed for the CSV file, open any dgn containing levels
and from Level Manager, go to File > Export  and select Excel CSV Files in the “Save As
Type” option. That will give you a file to start from with the correct formatting.

Always remember to utilise the level description to allow users to order layers and search
using English terms. It is good practice to build level filters as well to allow users to reduce
the list of levels they have to work with. If using filters, use wildcards rather than fixed level
groups (e.g. “A-Ss_25*” to pick up all architectural Wall systems).

In AECOsim, it is additionally advisable to create Families and Parts to match the levels.
Parts are the “visual representation” of any component, and so are directly linked to level
symbology. This allows a simple one-to-one mapping for new (& experienced) users to
understand which Part relates to which level. It also means most of your Part definitions
can simply be set to ByLevel, and users can still employ Level Overrides if they need to
adjust one part on one sheet without having to create new parts.

Once the dgnlibs is defined, to load it automatically into all projects and files, add the path
and file name into your standards.cfg using

MS_DGNLIBLIST > path\filename.dgnlib.



Version 4.0.2

25

Nemetschek Vectorworks
The following is offered as an option for a more workable and software specific solution for
Vectorworks users implementing BS1192 or AEC layer naming in Vectorworks and in
particular Uniclass 2015 coding.

Notwithstanding the notion that in the BS1192:2007+A1:2015 construct for layer naming
the Uniclass 'code' should be read as one 'field' with underscores, i.e. A-Xx_YY_ZZ-
M_Description, the use of the underscore does not make best use of some of the features
recently added to design software and Vectorworks is no exception.

The recommendation is to use the hyphen throughout in lieu of the underscore.

By adopting the hyphen throughout, arguably the software appears more consistent, and
avoids confusion: the hyphen is used throughout the software as a separator, and not a
placeholder, or substitute for a space or other character.  This is in addition to making
better use of the hierarchical class lists in the Navigation and Organisation palette, or the
historical use of the hyphen to create pop-up menus when looking for classes in the Object
Information Palette or Class Menu.

Implementation
It is intended that a set of basic element class standard file will become available through
the AEC website.  A more advanced set, containing SL, Ss, and Pr table, plus specific
material hatches will be available via the Nemetschek VSS portal.

Refer to the AEC UK CAD Standards v4.0 for more information on the fields to be used.
Refer also to https://toolkit.thenbs.com/articles/classification.

Within this document, we recommend classes are named using the following fields, as a
minimum:

Author-UniclassTable-Group-SubGroup-Section*-Object*-Presentation-UserDescription-
View

Benefits
Classes are displayed in many windows in Vectorworks.  They appear when we create a
class, or assign a class to an element during its creation, e.g. a Wall 'Style', or Symbol.
These tend to display as a list irrespective of the preference to turn off the hierarchical or
pop-up menus.

The main class creation and editing windows tend to display them slightly differently.
These are the primarily the Navigation and Organisation palettes.

In the Navigation Palette (Window>Palettes>Navigation) and Organisation Dialogue
(Tools>Organisation), the hyphen can optionally be used to generate a hierarchical list or a
simple alphanumeric list. (Use the Hierarchy button in the dialogue to control this option).

In the Class Pop up menu (above the ruler), the hyphen creates a sub-menu.  Again, this
can be turned off to display a simple list. (Vectorworks Preferences > Session > Display
classes in pop-up menus hierarchically)

By changing the underscore to a hyphen, the Uniclass code is still legible, and the software
is easier to use and closer to how the hierarchical menu was designed to be used.
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It is also recommended that within any one Uniclass table, you should use the same
number of number sequences so that classes list correctly.  If you adopt Group, and Sub-
Group for some classes but only Group for others, those with Group only will list below
those with both group and Sub-Group.  A-Ee-25-M-Wall, lists below A-Ee-25-10-M-Wall.

Descriptions
All descriptions used in Uniclass 2015 should be used as found in most instances, or as
suggested by the AEC documentation.

However, where a description found in Uniclass 2015 refers to multiple elements, e.g. A-
Ee-2580-M-DoorsWindows, you should duplicate the class and divide the elements into
two or more classes,

e.g. A-Ee25-80-M-Door

and A-Ee25-80-M-Window.

Resources
We would recommend the same be adopted when naming all library content, i.e. Symbols,
Hatches, Walls, Slabs, Record Formats, Worksheet, and Image Fills.  Refer also to the
Vectorworks AEC UK BIM Standards section on naming Library Content.


